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Getting Started with
AutoCAD MEP

Welcome to AutoCAD MEP, an AutoCAD-based design and construction document

solution for mechanical, electrical, and plumbing engineers, designers, and drafters.

AutoCAD MEP includes many features you can use to design building systems

and coordinate your project drawings and construction documents.

To help you get started quickly, this guide introduces you to some basic features

and concepts of the software. Following a tutorial format, you learn the basics of

how to work with mechanical, piping, electrical, and plumbing systems using

AutoCAD MEP. For in-depth information on the topics discussed here, see “Getting

Started” in the AutoCAD MEP online help.

1
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Using This Tutorial
This tutorial is divided into lessons, each of which addresses a particular task. Each lesson contains step-by-step exercises
you can perform to achieve the goal of the lesson. Drawings, referred to as datasets, are included in the project files.

The lessons in this tutorial are designed to build upon your knowledge of AutoCAD®. If you are not familiar with basic
AutoCAD functions and commands, see the online AutoCAD® 2008 User’s Guide.

It is also assumed that you are familiar with basic AutoCAD MEP features such as tool palettes, the Properties palette,
and MEP snaps. If you are not familiar with the basic features and the user interface, see “Getting Started” in the
AutoCAD MEP online help.

Extracting the Project Datasets

You must extract the project files in order to complete any part of this tutorial. If you edit any of the project files, you
can extract the files again to reset the project to its original state.

1 If AutoCAD MEP is open, minimize it.

2 In Windows® Explorer, browse to C:\Program Files\AutoCAD MEP 2008\Tutorial.

If you are using AutoCAD MEP in a network environment, the tutorial files may be in a different location.
Contact your network administrator or CAD manager for the location of the tutorial files.

3 Double-click the dataset Getting_Started_with_AutoCAD_MEP.exe.

The datasets are contained in self-extracting files. When you double-click a dataset, the extraction software
opens.

4 In the Self-Extractor dialog, use the default folder for the target folder location: C:\My
Documents\Autodesk\My Projects.

5 If the correct path is not shown, enter C:\My Documents\Autodesk\My Projects, and click OK.

6 Click Unzip.

A message indicates the number of project files that were unzipped. These files were extracted to My
Documents\Autodesk\My Projects. The Windows® default location for My Documents is C:\Documents
and Settings\<user name>\My Documents.

7 Click OK in the message box, and click Close.

8 Restore AutoCAD MEP.

9 Click File menu ➤ Project Browser.

NOTE You must have a drawing open to access the Project Browser. If you do not have a drawing open, click

 on the Standard toolbar to create a new drawing.

10 In the Project Browser, click  if necessary to locate the project folder for the tutorials.

NOTE If you have been working with non-tutorial projects, you may need to browse to My
Documents\Autodesk\My Projects.

11 Double-click the project name Getting Started with AutoCAD MEP.

12 If you are prompted to re-path the project, click Yes.

13 Click Close to close the Project Browser.

14 On the Project Navigator, click the Project tab.

15 Under Current Project, verify that Name displays the correct project - Getting Started with AutoCAD MEP.

16 Keep the Project Navigator open, and begin the lesson.
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NOTE Completed drawings for each lesson are included in the appropriate constructs folder. To view an example
of how you can reference the mechanical, piping, and electrical drawings together to coordinate systems in a
single view, in the Project Navigator, click the Views tab, and double-click Systems Coordination to open the
view.

Working with Mechanical
In this lesson, you work in the HVAC workspace. You learn how to draw duct to connect the diffusers with a VAV box.
You also learn how to create a section for a portion of your drawing.

Drawing Duct

In this exercise, you draw duct to connect the VAV box to the diffusers.

Select the HVAC workspace

1 On the Workspaces toolbar, select HVAC.

When the HVAC workspace is active, the HVAC menu is displayed on the menu bar, and the HVAC tool
palette opens.

Open the dataset drawing

2 In the Project Navigator, click the Constructs tab, and expand Mechanical.

3 Double-click 2nd Floor Mechanical Plan to open the construct drawing.

The current display configuration is MEP Design. With the diffusers in place, you can turn off the ceiling
grid to improve visibility for drawing duct.

Add duct from the VAV box to diffusers

4 On the drawing window status bar, for current display configuration, click MEP Design, and select MEP
Basic 2-Line.

5 On the application status bar, verify that OTRACK is selected.

6 Right-click OSNAP, and click Settings.

7 In the Drafting Settings dialog, click the MEP Snaps tab.

8 Click Select All.

9 On the Object Snap tab, deselect Object Snap On. Click OK.
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10 In the drawing, select the VAV box.

11 Click the Add Duct grip.

12 In the Add Duct dialog, click Set capacity from object(s)  .

TIP To minimize the dialog while the command is active, click the pushpin  in the upper-right corner. When
you move the cursor off the dialog, it minimizes so that just the title bar is visible. To restore the dialog, move
the cursor over the title bar.

13 In the drawing, drag the cursor from left to right to create a window selection that includes the 4 diffusers.

14 Press Enter.

15 In the Add Duct dialog:

■ For System, select Supply - Low Pressure.

■ For Shape, select Round.

16 Click Calculator  .

The diameter changes to 400.
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17 In the drawing, specify the insertion point for the duct in the location shown.

18 Specify a second insertion point for the duct in the location shown.

19 In the Add Duct dialog, click Set capacity from object(s)  .

20 In the drawing, drag the cursor from left to right to create a selection window that includes the 2 top
diffusers. Press Enter.

21 In the Add Duct dialog, click Calculator  .
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The diameter changes to 280.

22 Use tracking lines to align the duct with the middle of the diffuser in the location shown. Click at the
tracking line intersection to specify the next point of the run.

23 Specify the next insertion point in the location shown. Note that an elbow was automatically added.

Reduce the duct to match the diffuser neck

24 In the Add Duct dialog, enter 200 for diameter.
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25 In the drawing, specify the last insertion point in the approximate location shown.

26 Press Enter.

27 In the drawing, select the elbow.

28 Click the Add Duct grip.

29 In the Add Duct dialog, enter 200 for the diameter.

30 Specify the insertion point to draw the duct in the location shown.

31 Press Enter.
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32 In the drawing, select the 280 mm duct just to the right of the tee.

33 On the Properties palette, enter 200 for the diameter.

34 Press Esc.

35 Pan and zoom to view the 2 top diffusers.

36 In the drawing, select the duct to the left of the tee.

37 Hold Ctrl and click the Add Duct grip to add flexible duct.
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38 Select the duct end snap on the diffuser.

39 With the command still active, draw a flexible duct to connect the duct with the other diffuser.

40 Press Enter.

41 Pan to display the 2 bottom diffusers.

42 On the command line, enter ductadd.

43 In the Add Ducts dialog, enter 200 for the diameter.

44 In the drawing, use tracking lines to draw duct from the main duct to align with the diffuser as shown.
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45 Press Enter.

46 If necessary, select the takeoff and click the Flip grip to rotate the takeoff in the proper direction.

47 On the command line, enter ductflexadd.

48 In the Add Ducts dialog, enter 200 for the diameter.

49 In the drawing, draw flexible duct from the last duct drawn to the diffuser.

50 Press Enter.

51 Repeat steps 42 through 50 to draw duct to the diffuser on the right.

52 Pan and zoom to view the drawing area.

53 On the Views toolbar, click SW Isometric  .
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54 Pan and zoom to view Common Space 200.

55 On the Views toolbar, click Top  .

Creating a Section

In this exercise, you create a cross section for the ductwork created in the previous exercises.

1 Pan and zoom to Common Space 200.

2 Click Window menu ➤ Pulldowns ➤ Document Pulldown.

3 Click Document menu ➤ Sections and Elevations ➤ Add Section Line.

4 Click the cursor at the 2 locations shown.

5 Press Enter twice.

6 In the drawing, select the section box.

7 Drag the Length grip to reduce the width of the section box to end to the right of the diffusers.
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8 With the section box still selected, right-click, and click Generate 2D Section.

9 In the Generate Section/Elevation dialog:

■ For Result Type, select 2D Section/Elevation Object with Hidden Line Removal.

■ For Style to Generate, select MEP Standard.

10 Under Selection Set, click Select Objects  .

11 In the drawing, drag the cursor from left to right to create a selection window that includes the duct,
diffusers, and VAV box in the section box.

12 Select the floor plan by placing the cursor over any building linework and clicking.

13 Press Enter to finish selecting objects to include in the section view.

14 In the Generate Section/Elevation dialog:

■ For Display Set, select MEP Basic 2-Line - Model.

■ For X, enter -8000.

■ For Y, enter 10000.

15 Click OK.

16 Pan and zoom to view the section.

Working with Piping
In this lesson, you work in the Piping workspace. You learn how to draw pipe to connect sprinklers in a drawing. You
also learn how to make modifications to selected piping.

Drawing Pipe

In this exercise, you draw pipe for a sprinkler system in Common Space 200.

Select the piping workspace

1 On the Workspaces toolbar, select Piping.

When the Piping workspace is active, the Piping menu is displayed on the menu bar, and the Piping tool
palette opens.

12 | Chapter 1   Getting Started with AutoCAD MEP



Open the dataset drawing

2 In the Project Navigator, click the Constructs tab, and expand Piping.

3 Double-click 2nd Floor Piping Plan to open the construct drawing.

The current display configuration is MEP Design. Ceiling grids are visible in this display configuration.

Set up the workspace

4 On the drawing window status bar, for current display configuration, click MEP Design, and select MEP
Basic 2-Line.

Add pipe to the sprinklers

5 On the application status bar, verify that SNAP is not selected and that OTRACK is selected.

6 Right-click OSNAP, and click Settings.

7 In the Drafting Settings dialog, click the MEP Snaps tab.

8 Click Select All.

9 On the Object Snap tab, deselect Object Snap On. Click OK.

10 On the Piping tool palette, click the Pipe tab.

11 Click the Pipe tool.

12 In the Add Pipes dialog:

■ For System, select Cold Water Supply.

■ For Routing Preference, select Generic Grooved and Threaded Steel.

■ For Nominal Size, enter 25.
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TIP To minimize the dialog while the command is active, click the pushpin  in the upper-right corner. When
you move the cursor off the dialog, it minimizes so that just the title bar is visible. To restore it, move the cursor
over the title bar.

13 In the drawing, specify the insertion point by clicking the pipe end connector on the takeoff as shown.

14 Use tracking lines to align the pipe segment along the centerline of the sprinkler. Click to insert the pipe
end in the location shown.

15 Press Enter twice.

Switch to model space to add pipe to sprinklers

16 On the application status bar, click Work  .

17 Double-click the top view of the drawing area, in the right viewport, to make it active.
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18 In the drawing, select the previously drawn pipe.

19 Click the Add Pipe grip.

20 In the Add Pipes dialog, verify that the previous settings are still in effect, including the routing preference.
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21 In the drawing, specify the endpoint for the pipe by moving the cursor to the top sprinkler and clicking
the pipe end connector.

22 On the command line, enter n to preview the next routing solution. Repeat until you see the first solution
again.

23 On the command line, enter a to accept that routing solution.

24 Press Enter twice.

25 Double-click the left viewport to make it active.

26 Pan and zoom to view the middle sprinkler.

TIP An efficient way to navigate the drawing window is to use the scroll wheel on the mouse. Turn the wheel
to zoom in or out, hold down the wheel button and drag to pan, or double-click the wheel button to zoom
extents. You can use these features even if a command is active.
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27 In the drawing, select the middle sprinkler, and click the Add Pipe grip.

28 In the Add Pipes dialog, for Nominal Size, enter 25.

29 In the Add Pipes dialog, click the Pipe Layout Preferences icon  .

30 On the Connections tab, under Connect with pipe, select the Use Tee option, and click OK.

31 In the drawing, connect to the main pipe by clicking the pipe curve connector in the location shown.

32 Press Enter twice.

33 Pan and zoom to view the bottom sprinkler.

34 Select the bottom sprinkler, and click the Add Pipe grip.

35 In the Add Pipes dialog, for Nominal size, enter 25.

36 In the drawing, specify the insertion point by clicking the pipe curve connector.

37 Press Enter twice.
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38 Pan and zoom to view the sprinkler piping.

Add pipe to sprinklers in paper space view

39 On the application status bar, click Model  .

40 In the drawing, select the pipe below the middle sprinkler as shown.

41 Right-click, and click Add Selected.

42 In the Add Pipes dialog, verify that the previous settings, including the routing preference, are still in effect.
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43 In the drawing, specify the insertion point by clicking the pipe curve connector in the location shown.

44 Click the pipe end connector on the sprinkler to connect the pipe to the sprinkler.

45 On the command line, enter n to view the next solution, and enter a to accept the second routing solution.

46 Press Enter twice.

47 Pan and zoom to view the left sprinkler.

48 In the drawing, select the tee in the location shown, and click the Add Pipe grip.

49 In the Add Pipes dialog, verify that the previous settings are still in effect.
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50 In the drawing, specify the first endpoint along the sprinkler centerline as shown.

51 Click the pipe end connector on the sprinkler to connect the pipe to the sprinkler.

52 On the command line, enter n to preview the next routing solution.

53 On the command line, enter a to accept the second routing solution.

54 Press Enter twice.

55 Pan and zoom out to view the sprinkler piping.

Modifying Pipe

In this exercise, you modify the size of the pipe drawn in the previous exercise.

1 Pan and zoom to view the first pipe drawn.

2 In the drawing, select the first pipe drawn.
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3 Right-click, and click Pipe Modify.

4 In the Modify Pipe dialog:

■ For Routing Preference, select Generic Grooved and Threaded Steel.

■ For Nominal Size, enter 50.

5 Click Apply.

6 In the Maintain Connection dialog, select Modify to next junction/transition, and click OK.

7 Pan and zoom to view the pipe from the bottom sprinkler to the middle sprinkler.

8 In the drawing, select the pipe above the bottom sprinkler.
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9 Right-click, and click Pipe Modify.

10 In the Modify Pipe dialog:

■ For Routing Preference, select Generic Grooved and Threaded Steel.

■ For Nominal Size, enter 50.

TIP If necessary move the Modify Pipe dialog so that the selected pipe is in view.

11 Click Apply, and click OK.

12 In the drawing, select the pipe above the middle sprinkler.

13 Right-click, and click Pipe Modify.

14 In the Modify Pipe dialog:

■ For Routing Preference, select Generic Grooved and Threaded Steel.

■ For Nominal Size, enter 50.

15 Click Apply, and click OK.

16 Pan and zoom to view all 3 sprinklers.

Moving Pipe

In this exercise, you move pipe using associative movement.

1 In the drawing, select the pipe from the middle sprinkler to the right sprinkler.
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2 Click the Location grip.

3 Drag the pipe down to the location shown.

4 Click Undo to return the pipe to its original location.

5 On the drawing window status bar, for current display configuration, click Mechanical - Pipe by Size. In
this display configuration, pipes below a specified diameter display as 1-line. Fittings display symbolically.

Working with Electrical
In this lesson, you work in the Electrical workspace. You learn how to add receptacles, wire the receptacles, and add
lights. You also learn how to use the Circuit Manager to review and manage circuits. Finally, you learn how to create
a panel schedule for your drawing.

Adding Receptacles

In this exercise, you add receptacles to Common Space 200.
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Select the electrical workspace

1 On the Workspaces toolbar, select Electrical.

When the Electrical workspace is active, the Electrical menu is displayed on the menu bar, and the Electrical
tool palette opens.

Open the dataset drawing

2 In the Project Navigator, click the Constructs tab, and expand Electrical.

3 Double-click 2nd Floor Electrical Plan to open the construct drawing.

The current display configuration is MEP Design. Ceiling grids are visible in this display configuration.

Set up the workspace

4 On the drawing window status bar, for current display configuration, click MEP Design, and select Electrical
- Power.

Add receptacles

5 On the command line, enter deviceadd.

6 On the Design tab of the Properties palette:

■ For Style, select Duplex Receptacle.

■ For Layout Method, select Distance Around Space.

■ For Distance Between, enter 2500.

■ For Elevation, enter 450.

■ For System, select 230V Power (230V POWER).
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7 Under Circuits, click Electrical Properties.

8 Panels and circuits have been configured in the panel drawing. Because the drawings are linked, you can
assign devices in the current drawing to those circuits.

In the Electrical Properties dialog:

■ For Show Circuits from Panel, select P1 (Project Database).

■ For Circuit, select 1.

■ For Load, enter 100.

9 Click OK.

10 In the drawing, place the cursor over the space boundary line as shown to preview the receptacle placement.
Click to place the receptacles in the approximate location shown.

11 Press Enter to end the command.
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12 In the drawing, select the receptacles as shown.

13 Press Delete to remove the receptacles from the drawing.

Adding Wires

In this exercise, you add wires to connect the receptacles added in the previous exercise.

1 On the application status bar, deselect OSNAP.

2 On the command line, enter wireadd.

3 On the Design tab of the Properties palette:

■ For Style, select PVC Multi.

■ For Segment, select Arc.

■ For Height, enter 100.

■ For Offset, select Right.

■ For System, 230V Power Wiring (230V POWER).

4 Pan and zoom to the receptacles at the bottom of the drawing.

TIP An efficient way to navigate the drawing window is to use the scroll wheel on the mouse. Turn the wheel
to zoom in or out, hold down the wheel button and drag to pan, or double-click the wheel button to zoom
extents. You can use these features even if a command is active.
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5 In the drawing, click the electrical end connector in the location shown.

6 Click the electrical end connector on the next receptacle.

7 Continue wiring the remaining receptacles. Pan and zoom to view the receptacles as necessary.

8 After clicking the last receptacle, press Enter to add a homerun.

9 Click to specify the end of the homerun.

10 Select the homerun wire.

11 Click the Flip Tickmark grip.
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12 Press Esc.

Adding Lighting

In this exercise, you add additional lighting to Common Space 200.

1 On the drawing window status bar, for current display configuration, click Electrical - Power, and select
Electrical - Lighting.

Ceiling grids display, while receptacles and power wiring do not display.

2 In the drawing, select the existing lighting and its tag.

3 Right-click, and click Basic Modify tools ➤ Array.

4 In the Array dialog:

■ For Rows, enter 3.

■ For Columns, enter 3.

■ For Row Offset, enter -3000.

■ For Column Offset, enter 3000.

5 Click Preview.
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6 Click Accept.

7 On the drawing window status bar, for current display configuration, click Electrical - Lighting, and select
Electrical to display all electrical objects and turn off the ceiling grids.

8 In the drawing, select the original lighting fixture.

9 On the Design tab of the Properties palette, click Electrical Properties.

10 In the Electrical Properties dialog, notice that the additional lighting objects are assigned to the same circuit
on the same panel. Each light has a load of 100VA. The load on Circuit 2 shows as 900VA, which is the
total load from all 9 lights.

Press Esc.

Using the Circuit Manager

In this exercise, you use the Circuit Manager to view circuits.

1 Click Electrical menu  ➤ Circuits  ➤ Circuit Manager.

2 In the Circuit Manager - Electrical Project Database dialog, expand P1, and select Power and Lighting.
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You can use this dialog to configure and manage circuits.

3 Click Cancel.

Creating a Panel Schedule

In this exercise, you create a panel schedule for your drawing.

1 Pan and zoom to view the electrical objects drawn in the entire floor plan.

2 On the Electrical tool palette, click the Tag & Schedule tab.

3 Click the Panel Schedule tool.

4 In the Panel Schedule dialog:

■ For Service, enter Power and Lighting.

■ For Fed From, enter L2.

■ For Supply Voltage, enter 230V.

■ For Incomer Type/Rating, enter 100A.

5 Click OK.

6 Pan and zoom to view the entire drawing.

7 Below the drawing, click to place the upper-left corner of the schedule in the location shown.

8 Pan and zoom to view the contents of the schedule.

Working with Plumbing
In this lesson, you work in the Plumbing workspace. You learn how to draw a waste line, connect fixtures to the line,
and add a vent line. You also learn how to create a fixture schedule for your drawing.

Drawing a Waste Line

In this exercise, you draw a plumbing line to serve as the main waste line.
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Select the plumbing workspace

1 On the Workspaces toolbar, select Plumbing.

When the Plumbing workspace is active, the Plumbing menu is displayed in the menu bar, and the Plumbing
tool palette opens.

Open the dataset drawing

2 In the Project Navigator, click the Constructs tab, and expand Plumbing.

3 Double-click 2nd Floor Plumbing Plan to open the construct drawing.

4 On the drawing window status bar, for current display configuration, click MEP Design, and select Plumbing.

Draw the waste line

5 Pan and zoom to the vertical waste stack.

TIP An efficient way to navigate the drawing window is to use the scroll wheel on the mouse. Turn the wheel
to zoom in or out, hold down the wheel button and drag to pan, or double-click the wheel button to zoom
extents. You can use these features even if a command is active.

6 In the drawing, select the waste stack.

7 Click the Add Plumbing Line grip on the left in the location shown.

8 In the Add Plumbing Lines dialog:

■ For System, select Sanitary Sewer.

■ For Style, select Black Pipe.
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TIP To minimize the dialog while the command is active, click the pushpin  in the upper-right corner. When
you move the cursor off the dialog, it minimizes so that just the title bar is visible. To restore it, move the cursor
over the title bar.

9 In the drawing, specify the pipe end in the location shown.

10 Press Enter.

11 On the Plumbing tool palette, click the Fittings tab.

12 Click the General Plumbing Fitting tool.

13 In the Add Plumbing Fittings dialog:

■ For Fittings, select Rodding Eye To Fall.

■ For System, select Sanitary Sewer.
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14 In the drawing, move the cursor to the end of the drain pipe, and click the pipe end connector.

15 Press Enter twice.

Connecting Fixtures

In this exercise, you connect fixtures to the waste line you drew in the previous exercise.

1 Pan and zoom to the toilet fixtures.

2 Select the toilet in the location shown.

3 Click the Add Plumbing Line grip on the drain.

4 In the Add Plumbing Lines dialog:

■ For System, select Sanitary Sewer.

■ For Style, select Black Pipe.
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5 In the drawing, move the cursor to the main drain pipe, and click the pipe curve connector in the location
shown.

6 In the Elevation Mismatch dialog, verify that Add Riser and at Fixture are selected.

7 Press Enter to end the command.

8 In the drawing, select the Sanitary Tee for the first toilet as shown.

9 Click the Add Plumbing Line grip.

10 In the drawing, move the cursor to the urinal, and click the pipe end connector in the location shown.
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11 In the Select Connector dialog, select Connect 2: Waste, and click OK.

12 In the Elevation Mismatch dialog, verify that Add Riser is selected.

13 Press Enter to end the command.

14 In the drawing, select the sanitary tee.

15 Click the Flip grip to rotate the tee in the proper direction.

16 With the tee still selected, on the Properties palette, select Double Swept Tee with Boss for the style.

17 Repeat steps 2 through 16 for the second, third, and fourth toilets.
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Drawing a Vent Line

In this exercise, you draw a vent line that connects to the sanitary waste line.

1 On the application status bar, verify that OTRACK is selected.

2 In the drawing, select the double swept tee with boss for the fixtures on the right.

3 Click the top Add Plumbing Line grip.

4 In the Add Plumbing Lines dialog:

■ For System, select Sanitary Vent.

■ For Style, select Black Pipe.

■ For Elevation, enter 2700.

5 In the drawing, draw the first vent line at a 60 degree angle, and click to place the endpoint in the location
shown.
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6 Specify the next insertion point in the approximate location shown.

7 Use tracking lines to align the vent pipe with the vent stack centerline, and click in the location shown.

8 Specify the vent pipe endpoint by clicking the pipe end connector on the vent stack.

9 In the Elevation Mismatch dialog, verify that Add Riser and at Fixture are selected.

10 Press Enter to end the command.
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11 Repeat steps 2 through 10 to add vent lines to connect the remaining tees to the vent stack, being sure to
connect each one to the top line.

Creating a Fixture Schedule

In this exercise, you create a fixture schedule for your drawing.

1 Pan and zoom to view the bathrooms.

2 On the Plumbing tool palette, click the Tag & Schedule tab.

3 Click the Plumbing Fixture Schedule tool.

4 When prompted to select objects to tag, drag the cursor from left to right to create a selection window that
includes all of the fixtures in the bathrooms as shown.

5 Press Enter.

6 Below the drawing, click to specify the upper-left corner of the schedule below the drawing.

7 Press Enter to automatically size the schedule table.

8 Pan and zoom to view the contents of the table.
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